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The Report Viewer

The Report Viewer (RV) is a GUI program created to view and analyse the turn reports sent by the 
Galaxy Server. 

Please read the Player's Manual (Galaxy.pdf) before reading this document for better understanding 
what it is all about.

The RV is pretty basic and not very sophisticated. The Universe, all the objects like stars, planets, 
ships, and so on, look how it has been programmed by the RV: another program could do it 
completely different. The server program doesn't control or make any influence on the images you 
can see in the RV, except the national flags – they are stored by the server and placed in the reports. 

One day someone may decide to write a better program to view the reports – everybody is welcome 
to do so. Ask the GM for help about the report file formats and the API DLL.
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Reports

The report files are independent from each other. Each report has comprehensive information about 
the World from the Nation's perspective.

A report file name has following syntax:

<Nation Name>__turn_<turn number>.rep

Where:

• Nation Name is a name of the nation you rule. All the spaces (if they are) are replaced by the
underscore character '_'

• Turn number – is a number of a turn the report has been created for.

Examples:

Federation__turn_00033.rep : report file for nation 'Federation', turn 33

Great_Warriors__turn_00000.rep : report file for nation 'Great Warriors', turn 0 (initial 
turn).

A turn report is a text file, by structure close to '*.ini' files. Each section corresponds to specific sort 
of data. The information inside is quite technical and cryptic and is not a subject of this guide.

The server sends report compressed using 'rar' archiver. So, the files you receive in the turn 
reports emails in fact contain the archives with '*.rar' extensions:

Federation__turn_00033.rar

You can extract the report file manually or just open it in the RV – it 'understands' the 'rar-ed' files.
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Installation and Upgrade

The RV can be downloaded from here http://galaxy.magix.net/public/DownloadViewer.html as a 
'rar' archive. Depending on the platform the archive is 'GalaxyReportViewer_win.rar' or 
'GalaxyReportViewer_linux.rar'.

To unpack it select a convenient location (let's call it the Installation Folder) in your hard drive and 
use WinRar if you are a Windows user, or command 'rar x GalaxyReportViewer_linux.rar' for Linux
users. The RV does not have any installation program, it works by the rule 'copy&run'. To remove it
simply delete the Installation Folder.

The RV needs the write permissions to the location where it's been unpacked. It is necessary for:

• creating/changing its own configuration file 'guApi.zxs'

• generation of stars and planets images (in Data/bin/Stars and Data/bin/Planets)

If you want to upgrade your RV by a newer version (which are supposed to appear regularly), you 
need to download a fresh archive from the same location 
(http://galaxy.magix.net/public/DownloadViewer.html), unpack it somewhere and simply copy it 
over to the Installation Folder. All the old files will be replaced by new ones, but the generated 
images of stars and planets will not be touched.

To run the RV you should launch the executable file 'guMain' located in the Installation Folder. For
Linux users use command './guMain', for Windows users, just run 'guMain.exe'.

http://galaxy.magix.net/public/DownloadViewer.html
http://galaxy.magix.net/public/DownloadViewer.html
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Open a Report File

When you launch the RV you will immediately be prompted to select a report file to open:

The Open Report dialogue allows you to open the reports in compressed format (rar) or in the 
'native' text format 'rep' (if you have uncompressed it before). It is advisable to uncompress the 
report files when storing them because this will reduce an opening time, especially for big reports 
(on later stages of the game you may receive reports sized by a few megs). It is also advisable to 
store all the reports in one designated folder. The RV remembers the folder it has loaded a report the
'last time' from, for faster navigation.

With 'Open Report' dialogue at the start up you have only a choice either to select a report and click 
'Open' to load the report. Otherwise the RV will quit – it can't work without a loaded report.

After the selected report has been loaded successfully you will see two windows pop up on the 
screen:

• The main window with menus and log grid 

• The window with the star map

These two never close during the RV session. If you close the main window, you'll quit the 
program. The star map cannot be closed.

You may reposition the windows on the screen, change their size. The RV remembers their new 
positions/sizes.
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To open another report go to File → Open, and the same Open Report dialogue will pop up.

The RV can have only one report open at a time. It is not recommended to run more than one RV, 
because all the instances would share the same configuration file and would try to generate images 
in the same location.
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The Star Map

This map is the main operative window you use to analyse the current situation with the game. It 
shows all the star systems in your visibility, all the visible ship groups in the space, their directions 
(if available) and so on. When you open it for the first time it may have some default 
size/scale/position, generally not really convenient to work with:

You may want to resize the window and zoom it in to have a closer look.

There are several ways of 'zooming' or changing the current map scale and position:

• Use keys '+' to zoom in and '-' to zoom out

• (Only for Linux users, currently not working properly on Windows): use mouse wheel to 
zoom in/out

• Press control, then left mouse click on the left-top corner of the desired area and select the 
area to be zoomed in:
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After that you'll see a more detailed picture:

In this example we have the 38th turn for 'The Federation' – the situation looks quite developed.
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Star colours
One can see a number of star systems with different sizes and colours. The bright coloured stars are 
either your colonies or actually known to you star systems. 'Actually known' means you have an up-
to-date information about the star (the owner nation, size, level of materials, population, industry). 
These stars also have their names/ids displayed in bright bold colours. Your colonies and Actually 
Known star pictures are shown proportionally to their sizes – the bigger the star, the bigger the 
picture.

The unknown star systems (those your ships have never visited) are all shown with the same small 
size and coloured faded grey (like #18, #429, #23...).

The known star systems (those you ships have visited before, but then left) are shown with the 
actual size, but with the same grey colour (like #26, #34, #3, #98...). Their names/ids have faded 
colours. You have not up-to-date information about such stars.

About the colours of names/ids depending of star systems ownership:

• The stars with white names/ids (like 'Sol', 'Rye', #254...) are your colonies. These stars also 
always have a your flag 'waving' above. If a star name/id is underlined, like 'Jupiter', it 
means this star system has a restricted access.

• The stars with names containing info in square brackets like 'Sol(#20)[Col,Att] or 
#563[Dev] are controlled by a correspondent automated manager (or by several of them). 
The 3 letters abbreviation is used to mark an automated manager name. 'Col' states for 
'ColManager', 'Def' – for DefenceManager, 'Dev' – for DevManager, 'Att' – for 
AttackManager, 'Exp' – for ExplManager, 'Rep' – for RepairManager

• The stars with bright bold green names/ids (like #2, #258...) are uninhabited systems with 
your ships on their orbits (note: bright bold colours always indicate the up-to-date known 
star systems, i.e. stars with your ships on the orbit). Such stars never have any flags because 
they are uninhabited.

• The stars with bright bold red names/ids (like #6 – I see just one here) are enemies colonies  
with your ships on their orbits. The enemies stars always have a flag of a nation owner 
'waving' above.

• The stars with faded green names/ids (like #26, #52, #3...) are systems 'known' to you as  
uninhabited, but this information is not up-to-date, because currently there are no ships on 
their orbits (note: faded not bold colours always indicate not up-to-date known star systems, 
i.e. stars without your ships on the orbit). Such stars might already be occupied by other 
nations, but you don't know that, until you send a ship there to find out.

• The stars with faded red names/ids (like #30, #5, #60...) are systems 'known' to you as 
enemies colonies but this information is not up-to-date.

• The stars with bright bold sky blue names/ids (like #24, #19, #14...) are the colonies of your 
friends with your ships on their orbits. The colour indicates that your relationship to that 
nation is 'Peace', what doesn't automatically means, that 'they' are in peace with you.

• The stars with faded sky blue names/ids (like #64 and #10) are systems 'known' to you as 
friends colonies, but this information is not up-to-date
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Selecting a star
Let's have a close look at the map zooming it in a bit:

When you move a mouse pointer to a star it is market by 'white' circle and you can see some details 
in the status bar displaying (in this example) the owner nation (Ybsajulu), coordinates (33,61), star 
name or id (#34), galaxy name if applicable (Q1), and information about size, population, colonists, 
industry, live conditions and resource level.



12

Watching a star system
If you double-click on the star, you'll see the following window pops up:

This window shows you the planet belonging to the star system. This particular planet is a colony of
'Ybsajulu' nation, note 'Last reported 9 years ago'. The faded red colour indicates it's a known star 
system – an enemy colony with not up-to-date information.

One can see that the planet has some distinctive surface and colours. This is generated by the Report
Viewer itself depending on planet's size, live conditions and resource level. Each planet has unique 
surface and colours.

The star on the top right corner is shown 'grey', indicating that the planet has not up-to-date data.
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Let's double-click on 'your' colony #254:

All information in bright white indicates that it's your colony. Mind the colour of the planet and the 
star. The star has distinctive 'red' in it's colour which is a result of image generation of the Report 
Viewer. Like planets, each star has its own unique colour depending on size, resource level and live 
conditions of the planet it owns.
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When you start the RV for the first time all your colonies and actually known systems will be 
displayed as 'white' stars like here:

This is because the RV has not generated the nice looking images yet. If you double-click on the 
star #254, the image will be plain like this:
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The images are generated by the background process inside the RV. This process pauses when you 
move the map around, and silently resumes when you don't touch the map. It takes a while to 
generate a star image and much more to generates a planet one. So, the best way to get the images 
generates is to leave the RV running for a while when you don't work with it.

The generated images are stored in the Installation Folder under Data/bin/Stars for stars and 
Data/bin/Planets for planets.
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Ships groups on the orbit

Let's have a look at another colony #4 of 'The Federation':

If a colony has any ships on its orbit they are shown here. The ships with the same type are grouped 
together. A number of ships in the group is shown on the left of the ship picture. If there is only one 
ship in the group, instead of a number of ships, the ship id or name is displayed. On this picture one 
can see 14 ships of type 'dk' and ship with id #222 of type 'Thunder'. Pointing to the group makes it 
selected and some details are shown in the status bar, like on the picture.
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Mouse right-click on a ship group while it is selected shows a pop-up menu with 2 items:

• Show ships in the group

• Show ship type

If you select the first one, a list of ships belonging to the selected group will pop up:

If you select the second menu item, you'll see the ship designer window in read-only mode showing
you all the ship components:
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Space Battles
Let's go back to the star map:

A diagonal cross on a star means a space battle has happened here during the last turn'. A colour of 
the cross indicates a winner. If it's 'white' – your ships have won, if it's 'red' – the enemy has won. 
To see the battle you need to right-click on the star and select 'Show battle' from the pop-up menu:
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You will see a Battle Viewer modal window. On this picture we see just 2 ships – the Federation 
ship 'Belfast' fights of an enemy scout.

To start/stop the battle animation press ENTER. The viewer stars showing you every single shot and
movement made by each ship. Some battles are large and this can take a while. Sometimes it can be
boring to watch when, say, a hundred lightly armed transport ships are trying to fire at a battle ship 
with shield and can't penetrate it. To avoid such long waiting you can switch off showing the shots 
which have been fully repulsed by the shield or/and the shots which have missed. Use 
BACKSPACE to show/hide the missed shots and SPACE to show/hide the shielded shots.

It is also possible to 'play' the battle by actions and sequences, but I wouldn't recommend it – this 
feature is 'playing up', especially when you go backwards. Hopefully, will be fixed in the future.

Not all launched missiles are shown during the battle view – only those who hit the target or were 
fired at. This is done to avoid showing lots of missile launches not reaching any targets. It’s boring 
to watch and takes long time.
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Bombing
A circle around a star indicates that a 'bombing' has happened here during the last turn':

The white circle means 'you bomb the enemy', the red one means opposite: 'the enemy bombs your 
colony'. Double-click the star to see what's going on.
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Here we see fairly little bombing caused by just one 'dk' ship #224 (this ship type is D1,L1x1) – the 
weakest ever combat ship you can construct. Nevertheless, being on enemy's colony orbit it bombs.

Here is another example of more devastating bombing (taken from other galaxy far away...):
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Ground Battles
A vertical cross on a star indicates that a 'ground battle happened here during the last turn':

The white cross means 'you have won', the red one means the opposite: 'the enemy has won'. On the
picture above on can see on the system #15 even three events have happen: a ground battle (red 
cross – enemy has won); the bombing (white circle – your ships have bombed the enemy colony), 
and the space battle (white diagonal cross – your ships have won).

To watch the battle right-click on the star and select from the pop-up menu item 'Ground Battles':
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You'll see a list of all ground battles happened in the star system during the last turn. Note: it can be 
more than one battle, if more than two sides have been involved. The ground battles are processed 
in the order of starting, so it is always two sides in the one battle.

Double-click on the battle you'd like to watch:

The Battle Viewer pops up in a modal window.

You can start/stop watching the battle by pressing ENTER. Use SPACE to avoid showing the shots 
repulsed by 'shield' – this will make the process a bit faster.
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Space groups
The blue dots with blue lines pointing the star systems are your ship groups in the space travelling 
to different destinations:

If you point a mouse to one of them, you'll see some information about the group in the status bar, 
showing a group id (always negative – space group feature), coordinates, destination (to <star id>), 
group mass (W=<mass in units>), speed and a number of years (turns) left to travel (ETA=<years>).

Right-click on the group, select an item 'Show ships in the group' from the pop-up menu, and you 
will see the list of the ships:
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In this example there is just one ship of type 'dk'.

The red dots with red lines pointing to your colonies are the approaching alien space groups:

If you point a mouse to one of them, you'll see some details about the group in the status bar:

It states the group id, coordinates, destination (one of your colonies), group mass (W=<mass>), 
speed and ETA. You can't see the ships inside a group, you can only judge by a mass about the size 
of the group. This group is probably an alien transport ship (has a characteristic mass 21.62).
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The purple dots without any lines are other alien groups in your visibility. They move somewhere 
from somewhere – you can't say, only guess. You may see a lot of them, like here:

If you point a mouse to one of them, you'll see some details in the status bar.

Not much of use, but gives you some ideas about activity of alien ships in your district of the 
galaxy.
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Ship groups

The ship groups are shown near the star systems. They become visible when you zoom in 
considerably:

The ships are shown the same way as near the planets: ships of the same types are grouped together 
with a number of ships in the group on the left. If there is only one ship in the group, its id is 
displayed instead of the number of ships.

The ship colours indicate their relationship to the nation you rule. The white ships are yours, the red
ones are enemies, the sky blue ones are the ships of your friends (the nations you have declared the 
peace, but again – this doesn't mean they are in peace with you).

Right-click on a ship group to see the ships or their types.
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The white lines starting from a ship group to some star system show the 'launched' ships and their 
destinations:

Making a bit closer look one can see the ship group is launched to the system #77:
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The Lists

Apart from the star map you can find lots of useful information in the lists. Every list contains some
specific information in a grid view. You can sort the items by any column if you click on the column
header.

Go to main window and click on menu item 'Lists', then select a list you'd like to see.

Report Messages
This list contains different tips and announcements coming along with the report. Currently there 
are just a few of them, like 'Some nation has been destroyed', or 'Someone has been awarded a title 
Baron', and so on. In the future the server will generate more and more announcements and tips to 
point you at some important facts or issues happened during the turn.

If there are any report messages in the report, the list will pop up automatically when you load the 
report. You can view it any time later, navigating to File → Lists → Report Messages.
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Stars
The list contains all the visible stars with all their data:

Double-click on the selected star to see the 'planet view':
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If you do a right-click on the selected star in the list, you'll see a pop-up menu with one item 'Locate
star on the map'. If you click it, the star map will reposition itself to show the selected star system 
right in the map centre:
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Ships
List of all your ships and other nation ships located at your colonies or in the systems where your 
ships are. This list is a bit messy, I am seriously thinking about separating it on several smaller lists, 
but currently this is what we have:

Mind 'Nation' column to understand what nation the ship belongs to.

Double-click on the selected ship to see the ship designer view in read-only mode to check the ship 
construction. A right-click will pop up a menu like in the Stars list, with one item 'Locate the ship 
on the map'. If you click the item, the star map will reposition itself to show the star system where 
the selected ship is currently on the orbit in the map centre. Or, if the ship is in space, the map will 
show the space group, the ship belongs to, in the map centre.
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Ship Types
The list contains all your ship types and actual number of existing ships for each of them:

Double-click on the selected type to see a list of all the ships belonging to the type:

This list behaves the same way as the Ships list above (you can watch the ship in the designer or 
locate it on the map).

Right-click on the selected ship type pops up a menu with two items:

• Show ship type: this will display a ship designer in the design mode. So, you can create a 
new ship type from an existing ship type, making some changes, and the save it in the 
command editor

• Show ships: the same if you have double-clicked on the selected ship type
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Fleets
This is a list of all the fleets you have, including the system fleets. The list contains a number of 
ships for each fleet and assignment information:

The 'assignment information' shows where the fleet has been assigned to move to (actually for ships
list this column has the same meaning). 'Moving to star #54: 35->111->105->54' shows the route 
from current location #35 to the final destination #54, visiting on the way the systems #111 and 
#105. Such a 'route' has been calculated to avoid the 'jumps' bigger than 10LY.

Double-click on the selected fleet will pop up the list of ships belonging to the fleet:
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Space Groups
A list of all the space groups in your visibility:

Each item in the lists is coloured according the the group colour on the star map.

The blue lines are your groups – their mass, destination, speed and ETA are well known. Double-
click on the blue line will show you a list of ships belonging to the group. A right-click will pop up 
a menu with two items:

• Locate the group on the map: this will place the group in the centre of the star map

• Show ships in the group: the same effect as a double-click

The red lines are the alien groups approaching to your colonies -  their mass, destination, speed and 
ETA are known. You can't see the ships belonging to the group, but you can locate it on the map via 
right-click pop up menu.

The purple lines are the unknown alien groups – you know nothing about them apart from the 
coordinates. You can locate them on the map by usual way (right-click...).
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Transport Orders
Is a list of all the orders assigned to the Transport Manager:

Most of the orders are always in progress – very rare you'll see something else.
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Production Orders
Contains a list of all the production orders:

It's an important list to have a look at periodically.

If 'Colony' is empty, it means the order is a 'common' one, i.e. not assigned to any specific colony. 
These orders are always 'waiting'. The Production Manager distributes the common orders by parts 
to colonies for actual execution. The 'star orders' always have not empty value in 'Colony' column.

Column 'Produced' shows actually produced mass for the order. When it will be equal to 'Ordered', 
the order is done and disappear from the list.

Column 'Info' shows what has been ordered. Column 'type' shows a type of production.

If you have too many 'waiting' orders, may be you should think about cancelling some of them. It is 
safe to cancel orders in 'waiting' status – you won't loose any Production Units.
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Bombings
Here is a list of all bombings happened during the turn:

The 'Damage Info' column shows how bad an effect of the bombing is. 'Wiped' means the colony 
has been completely destroyed, i.e. no more population left. 'Damaged' means that some of the 
population has been killed or some of industry has been destroyed.

Double-click on the selected bombing line will display the planet view:
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Right-click on the selected bombing will pop up a menu 'Locate star on the map'.
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Ground Battles
Contains a list of all ground battles you have witnessed during the turn:

In this example we see just one battle has happened. Double-click on the selected line will display 
the Ground Battle View window:

Right-click on the selected battle will pop up a menu item 'Locate star on the map'.
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Space Battles
Displays a list of all the space battles you have witnessed during the last turn:

The list indicates where the battle has happened (the star system) and list of the battle participants. 
The list of participants contains nations separated by comma with some information about their 
fleets participated in the battle in a format (<number of ships/total mass of ships>).

Double-click on the selected battle will display a modal window of the Battle Viewer:
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Right-click on the selected line will pop up already well known 'Locate star on the map' menu.
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Nations Rating
Contains a rating list of all the nations in your visibility ordered by the rating index:

This list can be not a full list of the nations – only those in your visibility. This explains why rating 
index may start not from '1' and have gaps. The full list can be found here: 
http://galaxy.magix.net/public/AllNations.html

The nations in the list are coloured according to your relationship with each nation. 'Black' – is your
nation. 'Red' – nations your have a state of war, 'Blue' – those you have a state of peace.

Some information can be 'N/A' (not available) if the nation ruler has decided not to publish it.

http://galaxy.magix.net/public/AllNations.html


45

Known Nations
Is a list of all the nations you have had contacts so far:

Column 'Nation' here is always your nation. Your known nations names are in column 'Known 
Nation'.

This grid shows some data (about technologies, total population and industry) 'gathered' by your 
ships contacted with aliens. These data can be not up-to-date. Mind the columns 'Last techs updated'
and 'Last pop/ind updated' showing a number of years (turns) ago the data were updated last time. 
'0' means up-to-date information (last turn), '9' means '9 years ago', 'N/A' means the data is not 
available at all.

This list might seem not relevant when you have all the data about aliens in the Rating list. But, 
remember. In the rating list the rulers can hide some data. Here you see your own intelligence 
information. Advice: keep an eye on your neighbours, build more scouts and send them around to 
get fresh information.
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Sciences
Contains a list of all your sciences:

Columns '% Drive', '% Weapon',... show percentage of production units to be spent on each 
technology during production.
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Money Transactions
Shows the list of money transactions happened during the last turn:

Column 'Delta' shown how much money was added or removed from your Treasury. Column 
'Result' shows the actual state of your Treasury after the transaction.

In the example shown on the picture we have:

• You had @47827.03 before the turn started

• @9209.60 were deduced from your treasury for fleet payments. The rest of money in your 
Treasury after that is @38617.43

• Then all the money from your Treasury @38617.43 were spent for production (it appears 
that there is some lack of money here – complete Treasury was wiped out by production 
costs). The Treasury after this is empty: @0

• Then you have production income of @23862.20 – this was 'produced' by the rest of 
Production Units you have. The Treasury after that has @23862.20

• The last line states how much do you have in the Treasury when the turn ends: @23862.20. 
The same value will appear in 'State before turn' in the next report.

In this grid the 'red' lines show 'credit' transactions, the 'blue' ones show the 'debit' transactions. The 
'green' lines show the states before and after the turn.
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Automated Managers
Contains a list of all the available Automated Managers:

Column 'Stars' shows a list of star systems managed by the manager. If there are not stars, all 
available stars are managed

Column 'Activity' indicates is the manager is enabled or not.

Column 'Priority' shows the default production orders priority for the manager.

Column 'Info' shows 'additional information'. Obviously here we can see the ship types assigned to 
the managers.
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The Tools

There are a few tools to help you with creating the orders.

Ship Designer

This tool is not great, but better than nothing at the moment. Here you can see an existing ship 
(View mode) or construct a new ship type visually, and then copy the ship code to the command 
editor (Design Mode). Go to Main Window Tools → Ship Designer to open the Ship Designer in 
Design Mode:

You'll see a dialogue with 'pre-constructed' simplest ever ship 'D1' which has only one component 
Drive with mass 1. A ship type should have at least one component, so you will not be able to 
remove the only line here.

Column 'Tech' shows a current technology level a component of a 'ship-to-be' would have, if you 
created a ship of this type in this turn. Or, if in View Mode, the column shows actual tech level of a 
component. Column 'D/Mass' means 'Destroyed Mass' (can never be greater than 'Mass') indicates a
component damages (always 0 in Design Mode). Column 'Efficiency' displays a component 
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efficiency (always 1 in Design Mode). Column 'Description' shows the component 'code' (see 
Player's Manual for details).

Double-click on the selected component in the grid will open a component edit/create dialogue in 
'Edit' mode:

Here you can change everything (for Drive, Shield, Cargo and Repair Unit the 'size' only) but the 
type of a component.

To add a new component use <INSERT>, to delete an existing one use <DELETE> keys.

A picture of a ship will be changing accordingly to the number, size and types of components you 
are adding or changing. Each component type has a designated trivial image.

After adding some more components the Ship Designer might look like this:



51

Note the data displayed at the right of the ship picture, they are quite important.

• Mass indicated a mass of the ship – the mass to be used in ship production. This ship on the 
picture has mass 98 units. What means the costs of production will be 980 production units 
(see Player's Manual for details)

• Mass with full cargo indicates a full ship mass when cargo component (if there is one) is 
fully loaded. In this example there is a small cargo hold of size 1. 

• Shield shows the strength of the protective field. It depends on the power of the Shield 
component and the full ship mass. In this example all the hits with power <= 9.521 will be 
repulsed (i.e. make no harm to the ship).

• Speed indicates a ship's speed with empty cargo bay.

• Speed with full cargo indicates a ship's speed with full cargo bay.

You should always mind the result speed and shield of the ship type you are constructing.

When you feel the ship type is ready click 'Save to order' button to save the ship type code in the 
order in Command Editor.

You'll see the following text there:

// New ship type 

create ship type ­­name MyTypeName ­­code D50,S20,L5x5@as,M3x3@as/3/1/0.3,C1,;

Change 'MyTypeName' to something suitable like 'Light Destroyer' or whatever:
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create ship type ­­name Light Destroyer ­­code 
D50,S20,L5x5@as,M3x3@as/3/1/0.3,C1,;

If you mean to create an armed Service ship (like a transport ship, but with some weapons), don't 
forget to add option '--service' to the command (see Player's Manual for details) to avoid the ships 
of this type to be treated as combat ships in the battles:

create ship type ­­name Shuttle ­­code D10,C10,L1x1@as ­­service;
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Command Editor

The Command Editor is a tool where you can play your order commands locally to make sure there 
are no mistakes in the order.

The Editor can be opened from the Main Window Tools → Command Editor or when you click 
'Save to order' button in the ship designer:

In the last case you can see the new ship type command was added in the end of the order – here 
you can change the type name and add parameter '--service' if necessary.

An order always should start with your login details. By default it it inserts some dummy command 
like:

login MyEmail@bbc.co.uk/MyPassword;

Change it to your real credentials to make it be acceptable by the server. For 'dry' run in the RV any 
login is fine – the RV just ignores that.

To change your login details 'permanently', you need to manually edit your config file 'guApi.zxs' 
located in the Installation Folder where you have 'installed' the Report Viewer. Quit the RV (to make
sure it will not overwrite your changes), open this file, find the section 'LogInCredentials':

…
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  section LogInCredentials 

  { 

    section The Federation 

    { 

      item "Email",    ""; 

      item "Password", ""; 

    } // The Federation 

  } // LogInCredentials 

…

Find the section with your nation name (here it is 'The Federation') and change email and password 
according to your credentials, for example:

...

    section The Federation 

    { 

      item "Email",    "qwerty@yahoo.com"; 

      item "Password", "123456"; 

    } // The Federation 

...

Save the file, open the RV again. If you open the same order you have already created with 'old' 
credentials, nothing will change. Your new email/password will appear only in new orders.

The Command Editor creates an '*.ord' file for each report you open. These files are saved in the 
same directory the correspondent report files.

If you want to create an order for a new turn, based on an order created before (for previous turn for
instance), click button 'Import' and select a 'template' report you would like to import.

To 'play' you order click button 'Run'. The RV will translate your order and indicate all the errors (if 
there are some):
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(Here I deliberately added a science with the same name )

Fix the errors and run again:

Only when there are no errors you will see the command have effect on the current report. In this 
example the created sciences will be added to the science list, the new ship type will appear in the 
Ship Types list, the ships #11 and #22 are indicated (by white lines) that 'launched' to their 
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destinations, and so on.

Clicking on 'Run' also automatically saves the order. You can do 'save' explicitly by clicking on 
button 'Save'.

When the Order is ready, you can copy&paste it to your email program and send to the server.

If your RV is up-to-date, it is nearly guaranteed, that the order will be processed on the server side 
without any errors. The RV works with an API DLL which contains quite a bit of the server code 
what guarantees the same behaviour during command translation and local execution. Always 
upgrade the RV to the newest version to be in 'sync' with the server.
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